The perfect printer for your HP CapShare e-copier

Ultra-sharp print quality
The HP LaserJet 2100 series printers are designed for people who demand uncompromising quality in everything they do and have a sharp eye for value. Most impressive is the true 1200 x 1200 dpi laser output, the highest in its class, which creates documents that demand attention with crisp, razor-sharp text and stunning graphics.

Sharper, faster and more expandable
HP LaserJet 2100 series printers deliver 10 pages per minute with no compromise in quality. Two paper trays/one tray per size provide ample paper capacity and a 4 MB of memory standard for fast printing of complex pages. Fast infrared delivers quick and easy walk-up printing from the HP CapShare e-copier information appliance and a variety of other digital devices.

Ideal for individuals and small workgroups 2100M and 2100TN
The HP LaserJet 2100 series printers push all of these advanced features into a printer that is affordable and compact enough for virtually any working environment. The HP LaserJet 2100 is easily expandable to all the features your growing business needs.

For more information about the HP OmniBook family of notebook PCs, visit our Web site at www.hp.com/omnibook.

The solution that puts quality, performance, and value on the same page
The HP LaserJet 2100, 2100M and 2100TN printers produce excellent monochrome output that’s ideal for many applications, from simple flyers to complex presentations.

A family of Notebook PCs to meet every business need
No matter what you’re looking for in a notebook PC for your business—whether it’s full features at a value price, or top-of-the-line power and multimedia performance—the HP OmniBook family of notebook PCs has the solution to meet your needs.

Combined with HP CapShare e-copier, OmniBook notebook PCs provide a quick and easy way to capture paper documents and e-mail or fax them while you’re on the go. HP OmniBook notebook PCs are fully compatible with HP CapShare e-copier and designed to work seamlessly with it. Simply copy your documents into the e-copier, then transfer them to your OmniBook notebook PC through the infrared port. It’s that easy!

For more information about the HP OmniBook family of notebook PCs, visit our Web site at www.hp.com/omnibook.

JetEye from Extended Systems—The Ideal Solution for HP CapShare E-Copier Users

JetEye Printer–ESI-9580B
Infrared printer adapter for any parallel printer
JetEye Printer provides a “walk-up-and-print” convenience for your HP CapShare e-copier, with no cable connections to make. The JetEye Printer allows a printer to communicate with an infrared-equipped portable device by connecting to any standard parallel printer port. In addition, regular network printing is not interrupted because of the JetEye Printer’s pass-through parallel connection.

JetEye PC–ESI-9680B
Infrared PC serial adapter for a desktop PC
JetEye PC enables your HP CapShare e-copier to transfer files to a desktop PC without connecting cables. The JetEye PC attaches to the serial port of any desktop PC and provides an infrared port for your computer to communicate with any infrared-equipped device.

Extended Systems
Contact Information
www.extendedsystems.com
800-235-7576
JetEye from Extended Systems
The perfect printer for your HP CapShare e-copier

Ultra-sharp print quality
The HP LaserJet 2100 series printers are designed for people who demand uncompromising quality, in everything they do and have a sharp eye for value. Most impressive is the true 1200 x 1200 dpi laser output, the highest in its class, which creates documents that demand attention with crisp, razor-sharp text and stunning graphics.

Sharper, faster and more expandable
HP LaserJet 2100 series printers deliver 10 pages per minute with no compromise in quality. Two paper trays boost productivity. A 48 MHz processor and 4 MB of memory are standard for fast printing of complex pages. Fast Infrared delivers quick and easy walk-up printing from the HP CapShare e-copier information appliance and a variety of other digital devices.

Ideal for individuals and small workgroups 2100M and 2100TN
The HP LaserJet 2100 series printers push all of these advanced features into a printer that's affordable and compact enough for virtually any working environment. The HP LaserJet 2100 is readily expandable to all the features your growing business needs.

• The HP LaserJet 2100M comes complete with HP PostScript Level II emulation and 8 MB of memory.
• The HP LaserJet 2100TN is a network-ready, right out of the box.

For more information about the HP LaserJet 2100 series printers, visit our Web site at www.hp.com/lj2100.

http://www.extendedsystems.com
800-235-7576

JetEye from Extended Systems—The Ideal Solution for HP CapShare E-Copier Users

• IrDA infrared communication standard
• Transmits and receives data up to 115,200 baud with baud rate switching
• Operates up to one meter (3 feet) away
• Includes QuickBeam Suite file transfer program

JetEye Printer—ESI-9580B
Infrared printer adapter for any parallel printer
JetEye Printer provides “walk-up-and-print” convenience for your HP CapShare e-copier, with no cable connections to make. The JetEye Printer allows a printer to communicate with an infrared-equipped portable device by connecting to any standard parallel printer port. In addition, regular network printing is not interrupted because of the JetEye Printer’s pass-through parallel connection.

• Supports Windows 95, Windows 98, Windows CD H/PC and H/PC Pro 2.0 or greater, Windows NT 4.0 operating systems and HP CapShare e-copier

JetEye PC—ESI-9680B
Infrared PC serial adapter for a desktop PC
JetEye PC enables your HP CapShare e-copier to transfer files to a desktop PC without connecting cables. The JetEye PC attaches to the serial port of any desktop PC and provides an infrared port for your computer to communicate with any infrared-equipped device.

• Supports Windows 95, Windows 98, Windows CD 2.x or greater, Windows NT 4.0 operating systems and HP CapShare e-copier
• Supports self-powered operation

www.extendedsystems.com
800-235-1716

A Family of Notebook PCs to meet every business need
No matter what you’re looking for in a notebook PC for your business—whether it’s full features at a value price, or top-of-the-line power and multimedia performance—the HP OmniBook family of notebook PCs has the solution to meet your needs.

Combined with HP CapShare e-copier, OmniBook notebook PCs provide a quick and easy way to capture paper documents and e-mail them while you’re on the go. HP OmniBook notebook PCs are fully compatible with HP CapShare e-copier and designed to work seamlessly with it. Simply copy your documents into the e-copier, then transfer them to your OmniBook notebook PC through the infrared port. It’s that easy!

For more information about the HP OmniBook family of notebook PCs, visit our Web site at www.hp.com/omnibook.
User Guide

© Copyright Hewlett-Packard Company 1999. All rights reserved. Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under the copyright laws.

NOTE: Certain governmental laws and regulations, such as copyright laws, may protect material copied by this product. The user is solely responsible for complying with all such laws and regulations. If you are uncertain about your rights, contact your legal advisor.

Part number: C6301-99900
First Edition
1 Getting Started
   Up and running ......................................................... 3
   Finding additional information ...................................... 4
   Latest HP CapShare upgrades and information ..................... 4

2 Charging and Installing the Batteries
   To charge the batteries .................................................. 5
   To install the batteries ................................................... 5
   Special considerations for international travelers .................. 6
   Battery care ............................................................... 6

3 Copying a Page
   Capture basics ............................................................ 7
   Your first capture .......................................................... 8
   Preferred capture path .................................................... 9
   Capture tips .............................................................. 10
   Capture sleeve ............................................................ 10
   What can I capture? ....................................................... 11
   Verify a captured page ................................................... 11
   Change the appliance capture mode ................................... 12

4 Getting to Know your HP CapShare Appliance
   Appliance buttons and functions ....................................... 13
   Use the appliance display menus ....................................... 15
   Save a copied page ........................................................ 16
   View a copied page ........................................................ 16
   Attach/Detach (group) captured pages ................................ 17
   Trim edges of page ........................................................ 18
   Memory usage ............................................................. 19
   Cleaning the HP CapShare appliance .................................. 19

5 Preparing to Send to a Computer
   Install the HP CapShare PC utility ..................................... 20
   Choosing a file format .................................................... 20
   Access the HP CapShare PC utility ..................................... 21
   Determine Infrared (IR) and serial port connectivity status ........ 22
   Uninstall the HP CapShare PC utility .................................. 22

6 Sending and Sharing Pages
   Send to your computer ................................................... 23
   Send to a printer ........................................................... 24
   Send to a device other than a computer or printer .................. 25
   Share a page, a group, or all pages stored in memory ............... 26
   Work on a Windows CE handheld PC ................................... 28
   Work on a Psion Series 5 handheld computer ......................... 30
   Work on a Nokia Communicator ........................................ 31

7 Technical Support and Warranty
   Warranty, Technical Support, and Repair .............................. 32
   Answering questions about your HP CapShare appliance ............ 33
   Regulatory information ................................................... 37
   Trademarks .................................................................. 38
1 Getting Started

Congratulations on your new HP CapShare 920 portable e-copier purchase.

Up and running

After opening the box, check what’s in the box, then refer to the Quick Start card for the fastest way to get up and running with your HP CapShare portable e-copier.

What ships in the box

The following items should be found in the HP CapShare 920 portable e-copier box:

- HP CapShare appliance
- Four uncharged NiMH batteries
- Battery charger
- Quick Start card
- Serial cable
- Soft cloth drawstring carrying pouch
- Capture sleeve
- HP CapShare CD
- User Guide

What to do if parts are missing

If you are missing anything that should have been in the box:

- Visit the HP CapShare appliance support website at the following address for technical support: http://www.hp.com/support/capshare
- or-
- Contact a local, authorized HP dealer.
- or-
- See HP Customer Care Telephone Support in this user guide (page 34) for customer care telephone numbers.
Finding additional information

By following the instruction on the Quick Start card, you will be able to copy pages with the HP CapShare portable e-copier. You can then share pages by sending them through a serial or infrared (IR) connection to the following devices:

- your computer
- a printer
- a handheld device

This user guide is a companion to the Quick Start card and the How do I... tab of the HP CapShare PC utility. The Executive Summary, located on the HP CapShare CD also provides additional help to get you started.

If you have questions that are not addressed in this guide, the How do I... tab of the HP CapShare PC utility found on the HP CapShare CD contains all of the information about the HP CapShare portable e-copier that was available at the time of publication.

Latest HP CapShare upgrades and information

Because the HP CapShare portable e-copier is one of the first portable capture and share appliances, new information about the appliance will become available as other HP CapShare appliance users report their successes.

On the HP CapShare appliance website, you can do the following:

- Find the latest in troubleshooting information.
- Contact HP support services concerning any questions you have about your appliance.
- Learn about appliance and software upgrades.
- Refer to a list of supported devices.

The website is found at http://www.capshare.hp.com
Charging and Installing the Batteries

The HP CapShare appliance requires two charged batteries in order to operate. Two fully charged batteries run the HP CapShare appliance for at least 50 copies.

Batteries should be paired when used for the first time, and the same two batteries should be used in the HP CapShare appliance and charged together. If you interchange batteries between pairs, you shorten the life and could ruin the batteries, which may result in poor operation of the appliance.

To charge the batteries

1. Place the batteries in the battery charger. If you are charging only two batteries, they must be placed in the same charging circuit. See the diagram inside the charger for more information.

2. Plug the charger into a wall outlet. If the LED on the charger does not light, make sure the batteries are properly installed in the charger and the outlet is active.

3. Allow four batteries to charge for approximately 14 hours. You can also quick-charge two batteries for two hours.

   Note: For optimal results, allow the batteries to charge to full capacity (10 to 14 hours).

4. When the batteries are fully charged, unplug the charger.

   Note: Charge only fully discharged batteries. The HP CapShare appliance display indicates when batteries are low and need to be recharged.

To install the batteries

1. Remove the battery compartment lid from the top of the HP CapShare appliance by squeezing gently on the back of the lid and lifting it upward.

2. Insert the batteries into the appliance as indicated on the diagram inside the battery compartment.
Special considerations for international travelers

If you are traveling internationally, you may not be able to recharge batteries using the charger that came with your HP CapShare appliance, because of differences in electrical outlets.

Battery chargers for international use are available in most airports. Please see the battery charger for details about power requirements.

Battery care

Storing batteries

After the batteries have been removed from the HP CapShare appliance or battery charger, store the batteries in a dry place and within the recommended storage temperature range from 50° F (10° C) to 86° F (30° C).

CAUTION

The batteries should not be stored in the battery charger.

When to purchase new batteries

You should purchase new batteries for your HP CapShare appliance when the batteries are useful for only a short time after recharging. NiMH batteries are good for up to 500 full recharge cycles.

Other battery types

Although NiMH batteries are recommended for extended operation time, two AA high-capacity Alkaline, NiCd, or NiMH batteries can also be used. You can also purchase a quick charger for NiMH batteries.

CAUTION

The charger shipped with the HP CapShare appliance can be used to recharge only NiMH batteries. “High capacity” NiMH and NiCd batteries require their own chargers, purchased where the batteries are sold.

For additional information about batteries, refer to the How do I... tab of the HP CapShare PC utility.
3 Copying a Page

Using the HP CapShare portable e-copier, you can capture the information you need, when you need it, by simply copying business cards, newspaper stories, magazine articles, flip charts and more.

Capture basics

Holding the HP CapShare appliance
For best results, hold the HP CapShare appliance with the display facing you, your thumb on the display, and your fingers on the Capture button on the back.
Because the display is made of strong, scratch-resistant material, you can place your thumb directly on the display. Although you can copy pages while holding the HP CapShare appliance in a variety of ways, this method is best for consistently successful page captures.

Capture button
After placing the HP CapShare appliance on the page you want to capture, press and release the Capture button on the back of the appliance to begin copying. The capture indicator light to the left of the display is on when a capture is in progress.
Lift the appliance off the page to end the capture process.

Note
The display is blank while capturing is in progress.

Placement of the HP CapShare appliance
When looking at the front of the appliance, the capture area begins approximately 0.5 inches (1.2 cm) in from the left and 0.3 inches (0.8 cm) in from the right side of the HP CapShare appliance capture base. Make sure that the information you want to capture is at least 0.5 inches (1.2 cm) in from the side of the appliance.
For most pages, place the HP CapShare appliance parallel to the edge of the paper.
Your first capture

Using the HP CapShare appliance is quick and simple.

Note

Use the Quick Start card to copy your first page.

1. Make sure that the page you want to capture is free of paper clips, staples, folds, wrinkles, or any other obstacles that may cause the HP CapShare appliance to tilt.

2. Turn the HP CapShare appliance on by pressing the Power button on the right side of the HP CapShare appliance.

3. Place the HP CapShare appliance on the upper-left corner of the page.

4. Press and release the Capture button and move the HP CapShare appliance down the left side of the page, to the right, then up the right-hand side of the page (U-shaped path).

Note

Keep the entire base of the appliance flat on the page at all times, and be sure to overlap the down and up paths by at least 0.5 inches (1.2 cm).

5. Lift the appliance off the page to stop the capture. You can also press and hold the Capture button for the duration of the capture.

The copied page is saved and a thumbnail view of the copied page now shows on the HP CapShare appliance display. The new thumbnail appears after the last previously captured page.

See Preferred capture path (page 9) for other paths that you can use.
Preferred capture path

For Normal or Graphics mode

For best results using Normal or Graphics mode, use a U-shaped path when capturing pages.

Be sure to keep the HP CapShare appliance in constant contact with the page you are capturing. Lift the appliance from the page to end the capture.

For Flip Chart mode

For the best results when capturing flip charts, use a side to side motion, copying only the portions of the page that contain information.

Pages copied in this mode are reduced to 25% of their original size. Therefore, letter-size pages copied in this mode are too small to read.

Other capture paths

You can also use other capture paths, as long as the total capture area does not exceed 119 square inches (767.55 square cm) when in Normal or Graphics mode or 13 square feet (1.2 square meters) when in Flip Chart mode. You may need to rotate the page on the appliance screen after capturing when using alternative capture paths.
Capture tips

Do not turn the HP CapShare appliance

The HP CapShare appliance can be turned only up to 45 degrees while capturing a page. To copy a page successfully, use the preferred U-shaped path and keep the display facing the same direction for the entire capture.

How to prevent skewed pages

The appliance will automatically attempt to straighten crooked (skewed) images. Any page skewed too much will be left unchanged. To avoid unwanted skew, make sure that the HP CapShare appliance is placed on the page with the base parallel to the top of the page, and slide the appliance toward you following the straight edge of the page.

Note

If the display shows a skewed thumbnail, copy the page again with the appliance placed parallel to the edge of the page.

Capture sleeve

For

- Small documents that are hard to hold
- High-gloss documents
- Documents that are too dark
- Wrinkled documents

To capture with the sleeve

1 Place document in the capture sleeve with image side facing the transparent sheet.
2 Place on a smooth flat surface, and capture through the transparent surface.

An overhead projector slide or a photocopy of the original may work as well.
What can I capture?

You can capture most documents with the HP CapShare appliance.

- In Normal or Graphics mode, the appliance can copy as little as 0.25 inches (.6 cm) of a document, which is even smaller than a business card, to as much as 119 square inches (767.55 square cm), which is the equivalent of a legal-size sheet of paper or a 25 inch (63.5 cm) long newspaper column.

- In Flip Chart mode, the appliance can copy an entire flip chart page. Just make sure the page you copy is flat and free from any obstructions, such as paper clips and staples, or that you work around any obstructions.

The HP CapShare appliance may not copy some high-gloss documents, such as glossy photos and magazine covers, or very dark paper, such as magazine pages with black background.

Verify a captured page

A thumbnail view of your copied page appears as a verification screen on the appliance display after the page is processed and saved.

When you first view the page, it represents exactly what you copied. You can now check the edges for cut-off text, gaps in information where the capture path did not overlap, and other problems. This thumbnail may have rough edges indicating the actual capture path. You can inspect the page by zooming in or rotating the page. The page becomes a smooth-edged thumbnail after any other function is used on the HP CapShare appliance.
Change the appliance capture mode

The HP CapShare appliance has three modes.

- **Normal mode** — Use this mode to capture text and drawings. The appliance can store 40 to 50 pages copied in Normal mode. This is the most common mode for capturing letter-size pages.

- **Graphics mode** — Use this mode to capture pages containing graphics or pictures. Because of the memory required to store graphics, the appliance can store only 10 to 15 pages copied in Graphics mode.

- **Flip Chart mode** — Use this mode to capture oversized pages. Pages copied in this mode will be reduced to 25 percent of the original size. The appliance can store 50 to 150 pages copied in Flip Chart mode. Any letter-size page copied in this mode will be too small to read.

To change the appliance capture mode

1. Press \.
2. Press \ or \ to highlight Set Capture Mode.
3. Press \ again to confirm the selection.
4. Press \ or \ to highlight the mode you prefer.
5. Press \ again to confirm the selection.

The current setting remains selected until you change it again manually. If you have selected Graphics mode or Flip Chart mode, the mode icon appears in the lower-right corner of the display.
4 Getting to Know your HP CapShare Appliance

Once you have captured (copied) a page or pages, you can view the pages, trim pages, attach and detach consecutive pages, rotate pages, and more.

Appliance buttons and functions

Front

Help button
Press to see Help topics. Get instructions and information on specific functions.

Tools button
Additional features are easily accessed here to select capture mode and language, plus attach/detach pages and trim pages.

Send button
Press to send copied pages to your computer, a printer, or another compatible device using an infrared (IR) or serial connection. Or, change settings for the way data is sent to other devices, including the printer paper size.

Zoom button
Zooms from thumbnail to 6 and 12 times the thumbnail size.

Capture indicator light
The capture indicator light goes on during a capture, and goes off when the capture ends. The capture indicator light may go out to signal a capture error.

Display
High-contrast LCD screen allows you to view copies and stored documents clearly.

Delete button
Press to delete captured pages. Note: Deleted pages cannot be recovered.

Free up memory by simply deleting any page or group of pages.

Navigation buttons
Press to:
• view copied pages
• view grouped pages
• highlight menu items
• cancel functions
• and more

Area button
Press to:
• view grouped pages
• highlight menu items
• cancel functions
• and more

Zoom button
Zooms from thumbnail to 6 and 12 times the thumbnail size.

Send button
Press to send copied pages to your computer, a printer, or another compatible device using an infrared (IR) or serial connection. Or, change settings for the way data is sent to other devices, including the printer paper size.

Tools button
Additional features are easily accessed here to select capture mode and language, plus attach/detach pages and trim pages.

Help button
Press to see Help topics. Get instructions and information on specific functions.
When using the serial port, make sure the HP logo side of the cable is facing the front of the HP CapShare appliance (The side with the LCD display).
Use the appliance display menus

On the HP CapShare appliance, you can attach and detach pages, trim pages, view and zoom in on pages, and change settings for sending to printers, computers, or other handheld devices.

- The Help menu includes instructions on how to use each of the features on the HP CapShare appliance. To access the Help menu, press \( \text{Help} \).
- The Tools menu allows you to select capture mode and language, plus attach and detach pages and trim pages. To access the Tools menu, press \( \text{Tools} \).
- To send a page, group, or all pages in memory, press \( \text{Send} \).
- To delete a page, group, or all pages in memory, press \( \text{Delete} \).

Once in the display menu:

1. Press \( \text{Up Arrow} \) to highlight the menu item you want. Menu items that are not available are grayed out.
2. Press the appropriate button to confirm the selection.
   - or -
   Press \( \text{Select} \) to cancel the selection.

For more information about the HP CapShare appliance buttons, see *Appliance buttons and functions* (page 13).
Save a copied page

Captured pages are saved automatically. If you do not want a page saved in the HP CapShare appliance memory, you must delete the captured page.

View a copied page

- Press \( \leftarrow \) or \( \rightarrow \) to move between thumbnails of the captured pages in the HP CapShare appliance memory.
- Press \( \downarrow \) or \( \uparrow \) to flip between captured pages in a group.
- The number at the bottom of the display indicates the group number you are viewing.
- When a group of attached pages is viewed, the page number X/Y is momentarily displayed.
- For easier viewing, press \( \text{Q} \) to zoom in on the page or \( \text{A} \) to rotate the page.

For more information about the HP CapShare appliance buttons, see *Appliance buttons and functions* (page 13).
Attach/Detach (group) captured pages

To organize pages captured from the same source or similar sources, you can attach consecutive pages together to create groups. When a group is sent to your computer, it is received as a single file.

Attach to previous (grouping)

You can attach captured pages to form groups of pages. Each page can be attached to the page in the queue in front of it by using the Attach to previous function. Groups are identified on the display with a paper clip icon, and a page number X/Y (for example, 2/8 if you are viewing the second page of an eight-page group).

Use this function when you capture several pages from a single article. When pages are grouped together, the group is sent as a single file to your computer, a printer, or a handheld device.

To attach a page

1. View the page you want to attach to a previous page.
2. Press .
3. Press again to confirm the selection.

The paper clip icon shows that the page is attached.

Note Only consecutive pages can be grouped.

Detach from previous (ungrouping)

If you decide you no longer want pages grouped as they are, you can detach captured pages from a group.

To detach a page

1. View the page you want to detach from a previous page.
2. Press .
3. Press again to confirm the selection.

The page is detached from the previous page, but all subsequent pages remain attached.

Note Each page must be detached individually. If the paper clip appears in the upper-left corner of the thumbnail, pages are still grouped.
Trim edges of page

The HP CapShare appliance allows you to trim unimportant information from the edges of copied pages.

CAUTION Once a trimmed page is saved, you cannot recover the trimmed portion of the page.

To trim the edges of a page
1. View the page you want to trim.
2. Press .
3. Press or to highlight Trim Edges of Page.
4. Press again to confirm the selection.

Note The dotted marquis delineate the portion of the page marked for trimming.

5. Press or to move the left marquis.
6. Press or to move the upper marquis.
7. Press to confirm the left and upper marquis and to start moving the right and lower marquis. The marquis indicate where the right and lower edges of the page will be trimmed.
8. Press or to move the right marquis.
9. Press or to move the lower marquis.
10. Press again to save the trimmed page.

When you finish trimming the page, a dialog appears while the new page is saved. You can press if you need to cancel the trimming. This is the only time you can cancel the trimming process once you have started.
Memory usage

The HP CapShare appliance can hold as many as 50 captured letter-size pages. If the memory is full, a warning message appears on the appliance display. To free memory, you need to delete captured pages.

**CAUTION** Deleting pages is permanent; deleted pages cannot be recovered.

To check the memory

The Memory Usage Indicator is found before the first thumbnail or after the last thumbnail.

Press ◯ or □ to find the Memory Usage Indicator.

Before clearing the memory, be sure that all captured pages you want to keep have been sent to your computer, a printer, or a handheld device.

Cleaning the HP CapShare appliance

The capture area

The HP CapShare appliance capture base must be clean to produce high-quality captured pages. Use the carrying pouch that came with the HP CapShare appliance to protect the appliance from objects that could soil or scratch the base.

To clean the base, wipe off the area with a soft, damp cloth.

The display window

Cleaning the display window does not affect captured page quality or performance of the HP CapShare appliance.

If you need to clean the display window to view your captured page thumbnails more clearly, wipe off the display with a soft, damp cloth.

**Note** Because the display is made of strong, scratch-resistant material, you can place your thumb directly on the display.
5 Preparing to Send to a Computer

In order to use your HP CapShare appliance to send information to your computer, you must have the HP CapShare PC utility installed. You can install this software from the HP CapShare CD that came in the box. When the utility is installed, a small HP CapShare icon appears on the Windows taskbar.

Install the HP CapShare PC utility

1. Close any open programs and insert the CD in your CD-ROM drive. The CD should start automatically.
2. If the CD does not start automatically, click Start, then Run, and then type D:\setup.exe, substituting D with the letter of your CD-ROM drive. Click OK.
3. Follow the instructions in the dialog boxes that appear. The software installation will guide you through the selection of the communication port (serial or infrared) that will be used to transfer documents to the computer.

Note: If you are sending only to a handheld computer running Windows CE, you do not need to install software on that device. For further instructions on sending to a Windows CE device, see Send to a device other than a computer or printer (page 25).

Choosing a file format

During installation of the HP CapShare PC utility, you chose a saving convention for documents received from the HP CapShare appliance:

- Automatic Save to File.
- Use the HP CapShare Save-to-File Assistant.

You do not have to open the HP CapShare PC utility to receive documents on your computer. Use the HP CapShare PC utility to change the way you handle the received documents.

When your computer receives documents, the documents are received in a Microsoft Windows Explorer folder with the naming convention you chose. If they are saved in Adobe Acrobat's .pdf format, then you can view them using the Adobe Acrobat Reader that was installed during software installation. If they are saved in single- or multi-page TIFF format, then you can view them using the Microsoft Imaging software that comes with Microsoft Windows. If you did not install the Microsoft Imaging software when you installed Windows, you can install it now.
Access the HP CapShare PC utility

The HP CapShare PC utility is a program that helps you change default settings for receiving documents on your computer, get help, and contact HP.

**Note**
You do not have to open the HP CapShare PC utility to receive documents on your computer.

Open the HP CapShare PC utility to do any of the following:

- Change your port connection.
- Change the transfer rate.
- Change the setting for receiving documents using the HP CapShare Save-to-File Assistant or Automatic Save to File.
- Learn how to contact HP.
- Access Help and support links.
- Find infrared (IR) information.

You can open the HP CapShare PC utility in one of three ways:

- Click the HP CapShare taskbar icon.
- Right-click the HP CapShare taskbar icon, and then click Open HP CapShare utility.
- From the Start menu, select Programs, then select HP CapShare, and then select HP CapShare utility.
Determine Infrared (IR) and serial port connectivity status

If you are having difficulty maintaining a connection to your computer, or need to know the status of the selected port, you can check the port status in the HP CapShare PC utility.

To determine the IR and serial port CapShare connectivity status

1. Open the HP CapShare PC utility.
   The utility opens to the Communication tab.
2. View the port status in the Current Status box on the left side of the dialog box. The color of the icon in the Windows taskbar also indicates the status of the selected port. The port is ready if the icon is gray.

   Note: For more information on IR and serial port selection see Select serial or infrared (IR) transfer type in the How do I... tab of the HP CapShare PC utility.

Uninstall the HP CapShare PC utility

If you decide you are no longer sending captured pages to your computer, you may want to uninstall the HP CapShare PC software.

To uninstall the HP CapShare PC software

1. Click Start, then select Settings, and then click Control Panel.
2. Double-click the Add/Remove Programs icon.
   The Add/Remove dialog box opens to the Install/Uninstall tab.
3. Click HP CapShare in the list of software that can be uninstalled.
4. Click the Add/Remove button on the lower-right side of the dialog box.
5. Click Yes when asked to confirm the uninstall process. The files are then updated.
6. Click OK when the files have been updated.
6 Sending and Sharing Pages

Send to your computer

Before trying to send pages to your computer, make sure that your computer is on and the HP CapShare software is installed.

If your computer has an infrared (IR) port, make sure that the IR drivers are installed and the IR port is active. This allows your computer to receive documents across IR from your HP CapShare appliance. If you do not have an IR port, connect the HP CapShare appliance to your computer with the serial cable that came with the appliance.

For additional information about working with documents on the computer, see the "How do I" tab in the HP CapShare PC utility.

Note
If you have trouble viewing your document on a device other than your computer, check the Send/Settings/Other Devices on your HP CapShare e-copier and select the opposite setting, either High Quality or FAX Format then resend the document to the other device.

Note
If you receive a “No device found” message on your HP CapShare e-copier while trying to send a document through infrared to your computer, check the following:
- Your HP CapShare e-copier is pointed at your computer's active infrared port? (Some computers have front and rear infrared ports.)
- Check your computer BIOS to make sure Infrared is enabled. (For assistance in enabling your infrared call your computer manufacturer.)
- If you send to a Windows CE device you need to have it ready to receive prior to sending.
Send to a printer

Before trying to send pages to a printer, make sure that the printer supports infrared (IR) data transfer either using built-in IR or an add-on IR adapter. Your HP CapShare appliance can send pages to most printers with IR ports. For best results, HP PCL-compatible or JetSend-compatible printers are recommended.

Note
If you send to a printer and your document does not print, check the printer for any errors. The HP CapShare appliance cannot detect if the printer is out of paper, has a paper jam, or has any other error condition.

Printer requirements
The HP CapShare appliance is compatible with most printers that have IR capability. In order to send information to a printer, you must ensure that IR connectivity is available.

Use the infrared (IR) port
To use IR to connect the HP CapShare appliance to a printer, you simply point the appliance toward the IR port on the printer and press on the HP CapShare appliance.

For more information about IR, go to the IrDA website at: http://www.irda.org

Recover from send errors
If the printer stops receiving a document for any reason, an error message appears on the HP CapShare appliance. For more information, see the “How do I” tab in the HP CapShare PC utility. If you have lost the connection, you must reconnect to the IR port within 20 seconds. When reconnected, the send continues where it left off. If the connection is broken for more than 20 seconds, you must send the page again in order to print it.

Print pages
Pages print as soon as the entire page has been sent. The pages are automatically rotated or scaled, if needed, to fit on the sheet of paper. If a document does not print, an error condition may have occurred in the printer.
Send to a device other than a computer or printer

Other supported devices include Windows CE handheld PCs, Psion series 5 handheld computers, and Nokia Communicators. All these devices have built-in capabilities like e-mail, e-fax, Internet access, and more. For information on the latest supported devices, visit the HP CapShare website at http://www.capshare.hp.com

You can then send a document from the receiving device using the device’s standard communication software (such as e-fax and e-mail).

Note: When renaming TIFF or .pdf files, you must add .tif or .pdf to the end of the file name.

Additional information

For more information, consult the individual device website or the user guide that came with the device.

For Windows CE handheld PCs:
- http://www.microsoft.com/windowsce/
- or-
Visit the website of your Window CE device manufacturer

For Psion Series 5 handheld computers: http://www.psion.com/series5

For Nokia 9000 Communicator:
- In the US, http://www.nokia9000.com

Note: If you are sending a document for use as an e-fax, you should change the send setting to FAX format.

Before trying to send pages to a device other than a computer or printer, such as the Nokia 9000 Communicator, make sure that the device is a supported HP CapShare appliance receiver.

- For further information on receiving documents on Windows CE handheld PCs, see Working with HP CapShare documents on a Windows CE handheld PC (page 28).
- For further information on receiving documents on Psion series 5 handheld computers, see Working with HP CapShare documents on a Psion Series 5 handheld computer (page 30).
- For further information on receiving documents on the Nokia 9000 or 9110 Communicator, see Working with HP CapShare documents on a Nokia communicator (page 31).
Share a page, a group, or all pages stored in memory

Sharing pages does not automatically delete them from memory.

To send

1  Make a decision to use an IR or serial connection.

   Use an IR connection to send to your computer, a printer, or a handheld device.
   Locate the IR port on the receiving device.
   -or-
   If your computer is not IR-compatible, you must use a serial cable connection. Make sure the serial cable is securely connected to both your computer and the HP CapShare appliance.

   Note  Make sure the HP logo side of the cable is facing the front of the HP CapShare appliance (The side with the LCD display).

   Note  Connect the cable only when sending to your computer and remove the cable for all other appliance functions.

2  View the thumbnail of the page or group you want to send.

3  If you are sending to a printer, select a printer paper size.

4  Press  

   You can choose to send only the page currently shown on the display, the group currently shown, or all pages and groups in the memory.

5  Press  to highlight Current page, Group, or All Pages.

6  For an IR connection, make sure the HP CapShare appliance IR port is within 3 feet (1 meter) of the receiving device and pointing toward the IR port on the receiving device.

   The IR path must not be obstructed or broken during the entire send process. If the connection is broken for more than 20 seconds, the send stops.
   -or-
   If you are using a serial connection, make sure the cable is connected securely to both the HP CapShare appliance and your computer.
7 Press \( \text{SEND} \) to begin the send. You do not need to continue holding the Send button down after the send begins.

Until the IR connection is made, the HP CapShare appliance displays the Searching for device dialog box.

When the HP CapShare appliance successfully connects with your computer, the Receive Progress Indicator appears on your computer monitor. It will continue to appear until the send is complete or an error occurs.

If an error occurs, an Error screen appears on the appliance display telling you what has occurred so you can correct the error. For more information, see the How do I... tab on the HP CapShare PC utility.

8 Press \( \text{CANCEL} \) to cancel the send.
Work on a Windows CE handheld PC

Receive HP CapShare documents on your Windows CE handheld PC

1. On the handheld PC, tap the desktop tray icon or quit all programs to go to desktop view.
2. Tap the My Handheld PC icon twice to open it.
3. In the File menu, tap Receive.
4. Point the HP CapShare appliance’s IR port toward the IR port on your handheld PC.
5. On your HP CapShare appliance, select a page or group you want to send, and then press the Send button to send to your handheld PC. If the devices do not connect within a few seconds, cancel communications on both the HP CapShare appliance and the CE device before sending again.
6. When the files have been transmitted, close the status window on your handheld PC. The files appear automatically in the current folder in My Handheld PC.

Note: If you choose Send All from your HP CapShare appliance, you must be in the root directory of your handheld PC to retain proper file names. If you re-send a file, you may be asked to overwrite the old file or rename the new one. When renaming the new file, you must add .tif to the end of the name.

Received files appear on the device as TIFF files using the following naming conventions:
- Documents sent using the High Quality send format will be named CapXXXXX.tif where XXXX is a unique number for each document that is sent.
- Documents sent using the FAX Format send format will be named FaxXXXXX.tif.

For both High Quality and Fax Format documents, if the same document is sent to a device more than once, each instance will have a unique filename.
Send an HP CapShare document as a BSQUARE bFax Pro attachment

Note

The following instructions are specific to the BSQUARE bFax Pro software.

1. Start the BSQUARE bFax Pro software.
2. On the Edit menu, tap Add Recipient.
3. In the Add Recipient dialog box, type the recipient and the fax number, and then tap OK.
5. Select the document you want to send and tap OK.
6. On the Fax menu, tap Send Fax.

For more information, refer to the user guide that came with the handheld PC, or contact the manufacturer.

Send an HP CapShare document as an attachment to e-mail

1. Start the Inbox software.
2. Tap the New Message button on the toolbar to display the new message form.
3. Type an address in the To box, or tap the Address button in the toolbar and choose an address from the list, and then tap the down arrow in the To box and complete the rest of the header. Although it is not required, it is helpful to type a Subject line.
4. Tap the message body area and type your message.
5. On the File menu, tap Attachments.
6. Tap the paper clip.
7. Select the file you want to attach and tap OK.
8. Tap OK on the Attachments dialog box. The message is now attached.
9. Send the message.
Work on a Psion Series 5 handheld computer

Documents can be sent to a Psion Series 5 handheld computer, and can be stored or sent as e-mail, however, viewing and faxing of HP CapShare documents on the Psion was not available at the time of publication. Check the HP CapShare website at http://www.capshare.hp.com for the latest information on using the HP CapShare appliance with your Psion Series 5 handheld computer.

Receive HP CapShare documents on a Psion Series 5 handheld computer

On the Psion Series 5 handheld computer:
1 Tap the IR Beam icon on the left hand side of the screen.
2 Tap Infrared Receive.
3 Send the Current page, or Current group from the HP CapShare appliance and place the appliance so that the IR port is pointing toward the IR port on the Psion Series 5 handheld computer. A message appears on the HP CapShare appliance “Searching for device.” After the appliance connects to the handheld PC, it says “Sending 1 of X.”

Send an HP CapShare document as an attachment to e-mail

Note

The following directions are specific to the Psion Series 5 Message Suite.

1 Download the Psion Series 5 Message Suite from http://www.psion.com/ and install the Psion Series 5 Message Suite onto your Psion Series 5 handheld computer.
2 Set up the e-mail program to communicate properly (ISP, modem type, or other communication).
3 Tap the Extras icon on the lower-right-hand side of the screen.
4 Tap on the e-mail icon on the lower-right-hand side of the screen.
5 Tap on the New icon in the upper-right-hand side of the screen to start a new e-mail.
6 Tap on the e-mail in the submenu that appears.
7 Fill in the sending information.
8 Tap the attachments bar, and locate file to attach.
9 Send or save the e-mail.
Work on a Nokia Communicator

Note You should already have the Infrared Object Exchange add-on application installed on your Nokia Communicator. If you need the add-on application, go to the Nokia Communicator website at: http://www.nokia9000.com or HP’s Customer Care website at: http://www.hp.com/support

Send information from the HP CapShare appliance to the Nokia Communicator

On the Nokia Communicator:

1 Press the Extras Application button.
2 Arrow down to Infrared object exchange.
3 Press Select. The Infrared object exchange screen appears.
4 Press Receive. A screen appears that says “Ready to receive...” with an image of two gears spinning.
5 Place the HP CapShare appliance with the infrared (IR) port toward the Nokia Communicator IR port.
6 Send the Current page, or Current group from the HP CapShare appliance. A message appears on the HP CapShare appliance “Searching for device.” After the appliance connects to the Nokia Communicator, it says “Sending 1 of X.” When the file is received on the Nokia Communicator, a message will appear on the Nokia Communicator saying “Connected to the HP CapShare” and then “Receiving file(s) from the HP CapShare.”
7 Rename the file by pressing Menu and renaming the file.

Note The Nokia Communicator has two megabytes (2 MB) of storage for all user data. Because of limited storage capacity, it is recommended that you delete sent files if they are no longer needed.
Warranty, Technical Support, and Repair

Your HP CapShare appliance sets the standard for quality and reliability, so you have made an excellent choice. HP Customer Care, HP's award-winning product service and support, also backs the HP CapShare appliance. While HP products set the standard for quality and reliability, if there are any problems while your product is under warranty, we will repair or replace it at no charge. You also have access to HP Customer Care phone support under your product's standard warranty. And, you can always take advantage of our free 24-hour electronic web support. These programs and others are described in the paragraphs below.

Your HP CapShare 920 portable e-copier warranty

Hewlett-Packard warrants this product against defects in materials and workmanship for a period of one year from receipt by the customer unless an alternate warranty coverage is selected by the customer. If Hewlett-Packard receives notice of such defects during the warranty period, Hewlett-Packard will, at its option, either repair or replace products which prove to be defective.

Should Hewlett-Packard be unable to repair or replace the product within a reasonable amount of time, the customer's alternative remedy shall be a refund of the purchase price upon the return of the product to Hewlett-Packard.

This warranty gives the customer specific legal rights. Other rights, which vary from state to state or province to province, may be available.

Exclusions

The above warranty shall not apply to defects resulting from improper or inadequate maintenance by the customer, customer-supplied software or interfacing, unauthorized modifications or misuse, operation outside of the environmental specifications for the product, or improper site preparation and maintenance.

This warranty does not apply if the product has been damaged by accident or misuse.

Note

THE REMEDIES PROVIDED HEREIN ARE THE CUSTOMER'S SOLE AND EXCLUSIVE REMEDIES. IN NO EVENT SHALL HEWLETT-PACKARD BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT, TORT, OR ANY OTHER LEGAL THEORY.

In any state or province that does not allow the foregoing exclusion or limitation of incidental or consequential damages, the customer may have other remedies.
Disclaimer

The remedies in this warranty statement are your sole and exclusive remedies. Except as indicated above, in no event will HP be liable for loss of data or for direct, special, incidental, consequential (including lost profit), or other damage, whether based in contract, tort, or otherwise. Some states or provinces do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply.

Extending Your Warranty Coverage

HP SupportPack

SupportPack will extend your basic warranty from one year to three years. SupportPack gives you two additional years of free telephone support and Express Exchange repairs (next-day delivery) if needed. SupportPack must be obtained from your dealer within 90 days of purchasing your HP CapShare appliance. After signing up for SupportPack, you will register with Hewlett-Packard by phone, fax, e-mail, or regular mail to activate the service. SupportPack is a cost-effective way to control support costs, save time, gain greater security, and keep your business running smoothly.

The Store where you purchased your HP CapShare appliance can help too!

Another option for extending your warranty is to ask the authorized Hewlett-Packard dealer where you purchased your HP CapShare appliance about the support services and extended warranties the dealer may offer.

Answering questions about your HP CapShare appliance

You have the following options:

Option 1: The Help menu on your HP CapShare appliance

The Help Menu is available by pressing  on the front of the HP CapShare appliance, above the display.

1. Press  to access the Help menu.
2. Press  to highlight the menu item you want.
3. Press  to cancel.

Option 2: The HP CapShare PC utility

If the HP CapShare PC utility is installed on your computer, you have help available on your computer.

1. Open the HP CapShare PC utility in one of three ways:
   - Click the HP CapShare taskbar icon .
   - or-
   - Right-click the HP CapShare taskbar icon , and then click Open HP CapShare utility.
   - or-
   - From the Start menu, select Programs, then select HP CapShare, and then select HP CapShare utility.
2. Click the How do I tab.
3. Double-click the topic you want to view.
Option 3: HP Customer Care Online

Quickly find additional information at the HP CapShare appliance online support website at no charge. The goal of the CapShare online support is to have everything you need in one place, 24 hours a day, seven days a week at the following website:

http://www.hp.com/support/capshare/

At this website, you will find:

- Product information
- Frequently asked questions
- Troubleshooting information
- Software and firmware drivers that can be downloaded
- Support contacts

HP's general Customer Care online support is located at the following website:

http://www.hp.com/ghp/services.html

Option 4: HP Customer Care Telephone Support

When you talk to HP directly, highly trained service technicians at our HP Customer Care Center are ready to take your call.

Telephone support during the warranty period

Telephone support with an HP agent is offered through the HP Customer Care Center. During the warranty, you pay for the long distance phone call, but you won't be kept on hold for an extended period. That's because 95% of our calls are connected in fewer than three minutes. In an industry known for keeping customers waiting, we're proud of our quick response time. And because we connect you with a service technician who specializes in working with the HP CapShare appliance, most problems are solved in a single call.

Although you pay for the long distance call, during the warranty, HP provides free technical telephone support from an HP customer service representative at the Customer Care Center. For complete telephone support (problems with installation, configuration, and operation), please call:

- United States 208.333.5759
  (Monday to Friday 8 am to 8 pm EST)
- Canada 905.206.4663
  (Monday to Friday 8 am to Midnight EST).

European telephone support below is Monday to Friday 8.30 to 18.00 (CET).

- Austria + 43 (0)714 201080
- Belgium + 32 (0)2 626 8806 (Dutch)
- Belgium + 32 (0)2 626 8807 (French)
- Denmark + 45 39 29 4099
- English International + 44 (0)171 512 52 02
- Finland + 358 (0)203 47 288
- France + 33 (0)1 43 62 34 34
Germany  + 49 (0)180 52 58 143  
Ireland  + 353 (0)1 662 5525  
Israel  + 972 (0)9 9524848  
Italy  + 39 02 264 10350  
Netherlands  + 31 (0)20 606 8751  
Norway  + 47 22 11 6299  
Poland  + 48 22 519 06 00  
Portugal  + 351 (0)1 318 00 65  
Russian Federation  + 7 095 916 98 21  
South Africa  + 27 (0)11 8061030  
Spain  + 34 902 321 123  
Sweden  + 46 (0)8 619 2170  
Switzerland  + 41 (0)848 80 11 11  
Turkey  + 90 212 224 59 25  
United Kingdom  + 44 (0)171 912 52 02

While traveling in other parts of the world:  
The following phone numbers are provided for English-speaking customer support  
to help resolve problems with product operation only. (This does not include support for  
setup and configuration; that is provided at the Customer Care Centers listed above for the  
countries where the purchase was made.)  
In the phone numbers below, the number immediately behind the + is the country code.  
This is required only if you are calling from outside the specified country. The (0) needs to  
be dialed when calling from within the specified country.  
Australia  + 61 (0) 3.8877.8000  
Hong Kong  + 852 800.96.7729  
India  + 91 (0) 11.682.6035  
New Zealand  + 64 (0) 9.356.6640  
Singapore  + 65 (0) 272.5300  
Central and South America  + 52 5.258.46.00 (Mexico City)  
In Europe, the Middle East, and Africa  + 44 (0) 171.512.52.02 (London)  

Technical support phone numbers are subject to change. You can find current technical support phone  
numbers by going to the Customer Service section of the HP CapShare website at the following address:  
http://www.capshare.hp.com  
If you call, please have your HP CapShare appliance with you along with a complete description of the  
product problem.
Telephone support after the warranty period

The warranty period expires after one year of owning your HP CapShare appliance and you then have to pay for technical support. For quick questions in the US only, call 900.555.1500 ($2.50 per minute). Charges begin only when you are connected with a technician.

For calls from Canada or for calls in the US that you anticipate will be longer than ten minutes in length, call 800.999.1148. The fee is $25 per call, charged to your Visa or Master Card. (Prices are subject to change without notice.)

To locate technical support phone numbers outside the United States, go to the following website:
http://www.hp.com/support/capshare

If your HP CapShare appliance is defective when you open the box, return it for a new appliance from the dealer where you bought it.

HP Customer Care Repair and Express Exchange

Quality products are an HP trademark. However, if your HP CapShare appliance is ever in need of repair while under warranty, we will promptly repair or replace it. Call the HP Customer Care Center, and we will send you a repaired unit (like new).

In Europe, you will receive a repaired HP CapShare appliance delivered to you in approximately four to five business days. If you are traveling, HP will send the appliance to the location of your choice. After receiving the replacement product, the damaged unit is returned to HP.

In the US and Canada, you will be guided through Express Exchange. Where practical, you will receive a repaired HP CapShare appliance delivered to you on the next business day. If you are traveling, HP will send the appliance to the location of your choice. After receiving the replacement product, the damaged unit is to be returned to HP using a shipping label with postage prepaid by HP.

When returning the defective unit

Your HP authorized service reseller or HP Customer Care Center representative will give you detailed instructions about when and how to return the defective unit. It is important that you remove any accessories or cables and connectors that you installed or attached to the HP CapShare appliance before you return the defective unit. Examples of accessories are:

- Serial cable
- Batteries

Out-of-warranty repair

Contact an HP Service Center (see telephone book for listings) or call telephone support at the Customer Care Center (telephone number listed above) for information about out-of-warranty repair.
Regulatory information

German noise declaration
The German noise declaration is required in Germany. It provides noise output figures for the scanner.

Geraeuschemission LpA 70 dB am Arbeitsplatz
normaler Betrieb
nach DIN 45635 T.19
Sie Daten sind die Ergebnisse von Typpruefungen.

Japan VCCI declaration
The VCCI declaration is required in Japan. It is similar to the FCC regulations.

EU declaration of conformity

Declaration of Conformity according to ISO/IEC Guide 22 and IN 45014
Manufacturer’s name: Hewlett-Packard
Manufacturer's Address: Greeley Hardcopy Division 700 71st Avenue Greeley, CO 80634 USA

declares, that the product
Product Name: HP CapShare 920 Portable E-Copier Information Appliance
Model Number(s): C6300
Product Options: The following options may contain suffix:
C6301

conforms to the following Product Specifications:
Safety:
EN 60825-1:1994 Class 1
CSA 22.2 No.950-95
UL 1950 Third Edition
NOM-019-SCFI-1993

EMC:
FCC: 47 CFR parts 2,15 class B
AS/NZ 3548.1995
IEC 1000-3-2:1995 / EN61000-3-2:1995
IEC 1000-3-3:1994 / EN61000-3-3:1995
EN 50082-1:1992
IEC 801-2:1991 / prEN 55024-2:1992, 4kV CD, 8kV AD
IEC 801-3:1984 / prEN 55024-3:1991, 3V/m
IEC 801-4:1988 / prEN 55024-4:1992, 1kV Power Lines

Supplementary Information:
The product herewith complies with the requirements of the Low Voltage Directive 73/23/EEC and the EMC Directive 89/336/EEC and carries the CE-marking accordingly. LEDs in this product are Class I in accordance to EN60825-1 Greeley, Colorado, USA, September, 1998

7 Technical Support and Warranty 37
FCC declaration

FCC Declaration of Conformity

Manufacturer's name: Hewlett-Packard
Manufacturer's Address: Greeley Hardcopy Division
700 71st Avenue
Greeley, CO 80634
USA
Contact Person: GHC Regulatory Manager
Telephone: 970.350.5460
Product Name: HP CapShare 920 Portable E-Copier information appliance
Model Number(s): C6300 (may contain suffix)
Product Options: The following options may contain suffix:
C6301

The manufacturer listed above declares that this product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

Changes or modification of this equipment not expressly approved by Hewlett-Packard could void the user’s authority to operate this equipment. Only use the cables, connectors, power cords and accessories supplied with this equipment or expressly approved by Hewlett-Packard.
Test report on file: C6300-1
Date: September: 1998

Trademarks

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
Adobe® is a trademark of Adobe Systems Incorporated.
Pentium® is a U.S. registered trademark of Intel Corporation.
IrDA Feature Trademark is owned by the Infrared Data Association and used under license therefrom.
The perfect printer for your HP CapShare e-copier

Ultra-sharp print quality

The HP LaserJet 2100 series printers are designed for people who demand uncompromising quality in everything they do. And have a sharp eye for value. Most impressive is the true 1200 x 1200 dpi laser output, the highest in its class, which creates documents that demand attention with crisp, razor-sharp text and stunning graphics.

Sharper, faster and more expandable

HP LaserJet 2100 series printers deliver 10 pages per minute with no compromise in quality. Two paper trays hold up to 210 pages each and a 4 MB of memory are standard for fast printing of complex pages. Fast Infrared delivers quick and easy walk-up printing from the HP CapShare e-copier information appliance and a variety of other digital devices.

Ideal for individuals and small workgroups 2100M and 2100TN

The HP LaserJet 2100 series printers pack all of these advanced features into a printer that's affordable and compact enough for virtually any working environment. The HP LaserJet 2100 is easily expandable to all the features your growing business needs.

• The HP LaserJet 2100M comes complete with HP DeskJet Level II emulation and 4 MB of memory.
• The HP LaserJet 2100TN is a network-ready, right out of the box.

For more information about the HP LaserJet 2100 series printers, visit our Web site at www.hp.com/laserjet.

The solution that puts quality, performance, and value on the same page

The HP LaserJet 2100, 2100M and 2100TN printers produce excellent monochrome output that's ideal for many applications, from simple flyers to complex presentations.

Sharper, Faster, Expandable

A Family of Notebook PCs to meet every business need

No matter what you're looking for in a notebook PC for your business — whether it's full features at a value price, or top-of-the-line power and multimedia performance — the HP OmniBook family of notebook PCs has the solution to meet your needs.

Combined with HP CapShare e-copier, OmniBook notebook PCs provide a quick and easy way to capture paper documents and e-mail them while you're on the go. HP OmniBook notebook PCs are fully compatible with HP CapShare e-copier and designed to work seamlessly with it. Simply copy your documents into the e-copier, then transfer them to your OmniBook notebook PC through the infrared port. It's that easy!

For more information about the HP OmniBook family of notebook PCs, visit our Web site at www.hp.com/omnibook.

JetEye from Extended Systems—The Ideal Solution for HP CapShare E-Copier Users

• IrDA infrared communication standard
• Transmits and receives data up to 115,200 baud with baud rate switching
• Operates up to one meter (3 feet) away
• Includes QuickBeam Suite file transfer program

JetEye Printer — ESI-9580B

Infrared printer adapter for any parallel printer

JetEye Printer provides "walk-up-and-print" convenience for your HP CapShare e-copier, with no cable connections to make. The JetEye Printer allows a printer to communicate with an infrared-equipped portable device by connecting to any standard parallel printer port. In addition, regular network printing is not interrupted because of the JetEye Printer's pass-through parallel connection.

• Supports Windows 95, Windows 98, Windows CD H/PC and H/PC Pro 2.0 or greater, Windows NT 4.0 operating systems and HP CapShare e-copier

JetEye PC — ESI-9680B

Infrared PC serial adapter for a desktop PC

JetEye PC enables your HP CapShare e-copier to transfer files to a desktop PC without connecting cables. The JetEye PC attaches to the serial port of any desktop PC and provides an infrared port for your computer to communicate with any infrared-equipped device.

• Supports Windows 95, Windows 98, Windows CD H/PC and H/PC Pro 2.0 or greater, Windows NT 4.0 operating systems and HP CapShare e-copier
• Supports self-powered operation
The perfect printer for your HP CapShare e-copier

Ultra-sharp print quality

The HP LaserJet 2100 series printers are designed for people who demand uncompromising quality in everything they do and have a sharp eye for value. Most impressive is the true 1200 x 1200 dpi laser output, the highest in their class, which creates documents that demand attention with crisp, razor-sharp text and stunning graphics.

Sharper, faster and more expandable

HP LaserJet 2100 series printers deliver 10 pages per minute with no compromise in quality. Two paper trays/automated paper feed, a 66 MHz processor and 4 MB of memory are standard for fast printing of complex pages. Fast Infrared delivers quick and easy walk-up printing from the HP CapShare e-copier information appliance and a variety of other digital devices.

Ideal for individuals and small workgroups 2100M and 2100TN

The HP LaserJet 2100 series printers push all of these advanced features into a printer that is affordable and compact enough for virtually any working environment. The HP LaserJet 2100 is easily expandable to all the features your growing business requires.

• The HP LaserJet 2100M comes complete with HP PostScript Level 2 emulation and 8 MB of memory.
• The HP LaserJet 2100TN is network ready, right out of the box.

For more information about the HP LaserJet 2100 series printers, visit our Web site at www.hp.com/lj2100.

A Family of Notebook PCs to meet every business need

No matter what you’re looking for in a notebook PC for your business — whether it’s full features at a value price, or top-of-the-line power and multimedia performance — the HP OmniBook family of notebook PCs has the solution to meet your needs.

Combined with HP CapShare e-copier, OmniBook notebook PCs provide a quick and easy way to capture paper documents and e-mail them while you’re on the go. HP OmniBook notebook PCs are fully compatible with HP CapShare e-copier and designed to work seamlessly with it. Simply copy your documents into the e-copier, then transfer them to your OmniBook notebook PC through the infrared port. It’s that easy!

For more information about the HP OmniBook family of notebook PCs, visit our Web site at www.hp.com/omnibook.

J etEye from Extended Systems—The Ideal Solution for HP CapShare E-Copier Users

- IrDA infrared communication standard
- Transmits and receives data up to 115,200 baud with baud rate switching
- Operates up to one meter (3 feet) away
- Includes QuickBeam Suite file transfer program

JetEye Printer–ESI-9580B

Infrared printer adapter for any parallel printer

JetEye Printer provides “walk-up-and-print” convenience for your HP CapShare e-copier, with no cable connections to make. The JetEye Printer allows a printer to communicate with an infrared-equipped portable device by connecting to any standard parallel printer port. In addition, regular network printing is not interrupted because of the JetEye Printer’s pass-through parallel connection.

• Supports Windows 95, Windows 98, Windows CD/HP and H/PC Pro 2.0 or greater, Windows NT 4.0 operating systems and HP CapShare e-copier

JetEye PC–ESI-9680B

Infrared PC serial adapter for a desktop PC

JetEye PC enables your HP CapShare e-copier to transfer files to a desktop PC without connecting cables. The JetEye PC attaches to the serial port of any desktop PC and provides an infrared port for your computer to communicate with any infrared-equipped device.

• Supports Windows 95, Windows 98, Windows CD/HP and H/PC-Pro 2.0 or greater, Windows NT 4.0 operating systems and HP CapShare e-copier
• Supports self-powered operation